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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
ค าน า 

 
เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp  จัดท าขึ้นเพ่ือเป็นสื่อประกอบ 

การจัดการเรียนการสอน กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ในรายวิชาการออกแบบ
ผลิตภัณฑ์ รหัสวิชา ง30249 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 4 เพ่ือให้นักเรียนได้ศึกษา 
ในห้องเรียน นอกห้องเรียน หรือค้นคว้าเพ่ิมเติมด้วยตนเองตามล าดับขั้น ตามศักยภาพและ 
ความสามารถของตนเอง ซึ่งเอกสารประกอบการเรียนการใช้โปรแกรม SketchUp  มีทั้งหมด 5 เล่ม 
ดังนี้ 

เล่มที่ 1 รู้จักกับ SketchUp  
 เล่มที่ 2 พ้ืนฐานการท างานกับโมเดล 
 เล่มที่ 3 การวาดโครงร่างโมเดล 

เล่มที่ 4 การสร้างโมเดล 3 มิติ 
 เล่มที่ 5 น าเสนอด้วยซีน (Scenes) และแอนิเมชั่น (Animation) 
 
 ผู้จัดท าหวังเป็นอย่างยิ่งว่า เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp  เล่มที่ 1 
รู้จักกับ SketchUp  เล่มนี้จะเป็นประโยชน์ต่อครูผู้สอน สามารถน าไปใช้ในการจัดกิจกรรมการเรียน
การสอนให้มีประสิทธิภาพ  และนักเรียนสามารถเรียนรู้ได้เต็มตามศักยภาพ น าพาตนเองบรรลุ
เป้าหมายตามวัตถุประสงค์ที่ก าหนดไว้ 
 

 
พวงเพชร  ครุฑเงิน 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

สารบัญ 

 
เรื่อง 
 
ค าน า 
สารบัญ  
ค าแนะน าส าหรับครู  
ค าแนะน าส าหรับนักเรียน  
สาระส าคัญ 
จุดประสงค์การเรียนรู้ 
แบบทดสอบก่อนเรียน 
กระดาษค าตอบแบบทดสอบก่อนเรียน  
ใบความรู้ที่ 1 เรื่อง ความรู้เบื้องต้นเกี่ยวกับโปรแกรม SketchUp 
ใบงานที่ 1 รู้จักกับโปรแกรม  SketchUp ท าความรู้จักกับโปรแกรม SketchUp ….......................................................... 
ใบความรู้ที่ 2 เรื่อง เริ่มต้นใช้งานโปรแกรม SketchUp การใช้งาน Pro ในงาน ด้านต่างๆ 
ใบงานที่ 2 ส่วนประกอบหน้าจอโปรแกรม SketchUp 
ภาคผนวก 

หน้า 
 
ก 
ข 
ค 
ง 
จ 
1 
2 
6 
7 
11 
12 
22 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 

ค าแนะน าการใช้ส าหรับครู 

 
 
 เอกสารประกอบการเรียนการใช้โปรแกรม  SketchUp  เล่มที่ 1 เรื่อง รู้จักกับ Sketchup 
เป็นสื่อประกอบการเรียนการสอน ซึ่งใช้เวลาในการเรียนการสอน 2 ชั่วโมง ครูผู้สอนควรปฏิบัติดังนี้ 

1. ครูศึกษาเอกสารประกอบการเรียนและอ่านเนื้อหาสาระอย่างละเอียดรอบคอบพร้อมทั้งท า
ความเข้าใจกับเนื้อหาทุกชุดก่อนการใช้งาน 

2. ครูต้องเตรียมเอกสารประกอบการเรียนให้ครบถ้วนและเพียงพอกับจ านวนนักเรียน 
3. ครูชี้แจงให้นักเรียนทราบล าดับขั้นตอนและวิธีการใช้เอกสารประกอบการเรียนอย่างชัดเจน 
4. ครูชี้แจงให้นักเรียนทราบเกี่ยวกับบทบาทของนักเรียนในการเรียนโดยใช้เอกสาร

ประกอบการเรียนและความซื่อสัตย์โดยไม่ลอกเพ่ือน ไม่ให้เพ่ือนท าให้ หรือไม่ดูเฉลยก่อนลง
มือท าแบบฝึกหัด 

5. ครูแจ้งจุดประสงค์การเรียนรู้ให้นักเรียนทราบ 
6. ครูด าเนินการสอนตามกิจกรรมการเรียนรู้ที่ก าหนดไว้ในแผนการจัดการเรียนรู้  
7. ให้นักเรียนศึกษาเนื้อหาและท าแบบฝึกหัด 
8. ครูสังเกตความตั้งใจของนักเรียน ความสนใจในการเรียน ความรับผิดชอบในการท างานของ

นักเรียนอย่างใกล้ชิด เพื่อประเมินผลด้านทักษะและคุณลักษณะที่พึงประสงค์จากการปฏิบัติ
กิจกรรมระหว่างเรียน 

9. เวลาในการจัดกิจกรรมการเรียนโดยใช้เอกสารประกอบการเรียนของนักเรียนแต่ละคน อาจ
ไม่เท่ากัน ครูควรยืดหยุ่นตามความเหมาะสมและสถานการณ์ 

10. เมื่อนักเรียนท าเอกสารประกอบการเรียนเสร็จแล้ว ครูให้นักเรียนท าแบบทดสอบหลังเรียน 
เพ่ือประเมินความก้าวหน้าของนักเรียน 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

ค าแนะน าการใช้ส าหรับนักเรียน 

 
 
 ในการศึกษา เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp  เล่มที่ 1 เรื่อง รู้จักกับ 
Sketchup  นักเรียนควรปฏิบัติตามค าแนะน าดังนี้ 

1. อ่านค าชี้แจงเกี่ยวกับเอกสารประกอบการเรียนและค าแนะน าในการใช้เอกสาร
ประกอบการเรียนส าหรับนักเรียนให้เข้าใจก่อนลงมือท างานหรือท าการศึกษาทุกครั้ง  

2. นักเรียนท าแบบทดสอบก่อนเรียนเพื่อประเมินความรู้เดิมของนักเรียน 
3. นักเรียนศึกษาเนื้อหาจากเอกสารประกอบการเรียนและท ากิจกรรมด้วยความตั้งใจ โดย

มีครูคอยแนะน าและให้ค าปรึกษา 
4. ในการท ากิจกรรมตามเอกสารประกอบการเรียนทุกเล่ม ขอให้นักเรียนปฏิบัติด้วยความ

ตั้งใจและซ่ือสัตย์ต่อตนเอง  
5. นักเรียนท าแบบทดสอบหลังเรียนเพื่อดูความก้าวหน้าในการเรียนของนักเรียนหลังท า

กิจกรรมการเรียนการสอนโดยใช้เอกสารประกอบการเรียน 
6. หากนักเรียนยังไม่สามารถปฏิบัติได้ตามกรอบกิจกรรมของแต่ละใบงาน นักเรียนสามารถ

รับเอกสารประกอบการเรียนไปศึกษาและฝึกปฏิบัติเพ่ิมเติมนอกเวลาเรียน เพ่ือเพ่ิม
ความช านาญมากยิ่งขึ้น 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
ผลการเรียนรู้ 

 
 

มีความรู้ความเข้าใจคุณลักษณะ ความสามารถ ส่วนประกอบหลักของโปรแกรมและสามารถ
ใช้งานโปรแกรม SketchUp เบื้องต้นได้ 

 
 
 

สาระส าคัญ 
 
 

 SketchUp   เป็นโปรแกรมส าหรับสร้างแบบจ าลอง 3 มิติ  ที่มีความง่ายต่อการใช้งาน  
และเป็นที่นิยมอย่างกว้างขวาง โดยส่วนใหญ่จะถูกน ามาใช้ในงานออกแบบเชิงสถาปัตยกรรม  
งานออกแบบภายในและภายนอก การออกแบบกลไกลการท างานของเครื่องจักร เฟอร์นิเจอร์  
ภูมิประเทศ ผลิตภัณฑ์ รวมไปถึงงานออกแบบฉาก อาคาร และสิ่งก่อสร้างในเกม หรือจะเป็น  
การจัดฉากท า Story Boards ในงานภาพยนตรห์รือละครโทรทัศน์ก็สามารถท าได้ 

 
 
 

จุดประสงค์การเรียนรู้ 
 

 
1. อธิบายลักษณะและประโยชน์ของโปรแกรม ของโปรแกรม SketchUp ได้  (K) 
2. บอกส่วนประกอบและหน้าที่ของส่วนประกอบต่างๆ ของโปรแกรม Sketchup ได ้ (K) 
3. ใช้งานโปรแกรม SketchUp เบื้องต้นได้ (P) 
4. มีความใฝ่เรียนรู้ (A) 
 
 
 
 
  

1 

www.kr
oo

ba
nn

ok
.co

m



 

 

 

 

รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
แบบทดสอบก่อนเรียน 

 
ค าชี้แจง   ข้อสอบชุดนี้เป็นแบบเลือกตอบ จ านวน 10 ข้อ ข้อละ 1 คะแนน คะแนนเต็ม 10 คะแนน 
ค าสั่ง    ให้นักเรียนเลือกค าตอบที่ถูกต้องที่สุดเพียงค าตอบเดียวและท าเครื่องหมาย 
    กากบาท ( X)  ลงในกระดาษค าตอบ 
 
1. ข้อใดคือลักษณะของโปรแกรม SketchUp 

ก. โปรแกรมส าหรับการตกแต่งภาพหรือใช้ในการแปลงรูปภาพ 
ข. โปรแกรมส าหรับการดีไซน์ฉากโลโก้และภาพเคลื่อนไหวในรูปแบบ 3มิติ 
ค. โปรแกรมท่ีใช้ในการออกแบบ Model 3 มิติ สามารถสร้างงานเขียนแบบหรือภาพ

จ าลองได้ 
ง. โปรแกรมท่ีใช้ในการออกแบบ Model 2 มิติ สามารถสร้างงานเขียนแบบหรือ

ภาพเคลื่อนไหวได้ 
 

2. SketchUp สามารถประยุกต์ใช้กับงานทางด้านใดได้บ้าง 
 ก. การศึกษา      

ข. ออกแบบภายใน   
ค. วางผังเมือง      
ง. ถูกทุกข้อ 

 
3. ไฟล์สกุลในข้อใด ที่ได้จากการสร้างงานด้วยโปรแกรม SketchUp  

ก. skp 
ข. docx 
ค. avi 
ง. jpg 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
4. เข้าสู่โปรแกรม SketchUp เลือกข้อใด 

 ก.  

 ข.  

ค.  

ง.  
 

5. จากรูปข้อใดคือ ทูลบาร์ (Tool Bar) 

 
 
ก. หมายเลข 1 

ข. หมายเลข 2 

ค. หมายเลข 3 

ง. หมายเลข 4 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
6. จากรูปข้อใดคือ ช่องก าหนดค่าของเครื่องมือขณะท างาน 
 

      
 

 
 
7. จากรูปข้อใดคือ พื้นที่ท างาน (Drawing Area) 
 

      
  

ก. หมายเลข 1 

ข. หมายเลข 2 

ค. หมายเลข 3 

ง. หมายเลข 4 

ก. หมายเลข 1 

ข. หมายเลข 2 

ค. หมายเลข 3 

ง. หมายเลข 4 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 8. ค าสั่งในการเรียกหน้าต่าง Model info ก าหนดหน่วยวัด คือข้อใด 

      

 
 
 
 
 

9. การปรับมุมมอง   Orbit สามารถท าได้ตามข้อใด 
ก. กดค้างที่ลูกล้อเมาส์ พร้อมกดปุ่ม Ctrl 
ข. กดค้างที่ลูกล้อเมาส์ แล้วเลื่อนเมาส์ 
ค. กดค้างที่ลูกล้อเมาส์ พร้อมกดปุ่ม Shift 
ง. กลิ้งลูกล้อเมาส์ขึ้นลง 
 

10.  ค าสั่ง  Pan สามารถท าได้ตามข้อใด 
ก. กลิ้งลูกล้อเมาส์ขึ้นลงกดค้าง 
ข. กดค้างที่ลูกล้อเมาส์ แล้วเลื่อนเมาส์ 
ค. กดค้างที่ลูกล้อเมาส์ พร้อมกดปุ่ม Ctrl 
ง. กดค้างที่ลูกล้อเมาส์ พร้อมกดปุ่ม Shift 

  

ก. Window > Model Info 

ข. File > Model  Info 

ค. Edit > Model Info 

ง. Camera > Model Info  
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
กระดาษค าตอบแบบทดสอบก่อนเรียน 

 
เร่ือง รู้จักกับ SketchUp 

 

ชื่อ – สกุล ...................................................................... ชั้น .................... เลขที่.................... 
ค าชี้แจง  ให้เลือกค าตอบจากข้อสอบก่อนเรียนแล้วท าเครื่องหมายกากบาท (X) ลงในช่องที่ถูกท่ีสุด 
 

ข้อ ก ข ค ง 
1     
2     
3     
4     
5     
6     
7     
8     
9     
10     

 
เกณฑ์การประเมิน 

คะแนน ระดับคุณภาพ 
9-10 ดีมาก 
7-8 ดี 
5-6 พอใช้ 
0-4 ปรับปรุง 

 
เกณฑ์การตัดสิน 

ผ่านเกณฑ์   หมายถึง ได้ 5-10 คะแนนหรือได้ระดับ พอใช้ ดี หรือดีมาก  
ไม่ผ่านเกณฑ์ หมายถึง ได้ 0-4 คะแนนหรือได้ระดับ ปรับปรุง  

 
 

ผลการตัดสิน   ผ่านเกณฑ์  ไม่ผ่านเกณฑ์  
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 

ใบความรู้ที่ 1  
เร่ือง ความรู้เบื้องต้นเกี่ยวกับโปรแกรม SketchUp  

 
 
 
 
 
 

SketchUp เป็นโปรแกรมส าหรับออกแบบและสร้างโมเดล 3 มิติ โดยออกแบบมาให้ใช้งาน
ง่ายและเป็นที่นิยมอย่างกว้างขวาง เหมาะกับผู้ที่สนใจงานด้านการออกแบบโมเดลทั่วไป โดยที่ผู้ใช้ 
ไม่จ าเป็นต้องมีประสบการณ์ในการใช้งานโปรแกรมสร้างโมเดล 3 มิติ มาก่อนก็สามารถใช้ได้ เพราะ
หลักการท างานของโปรแกรมจะเป็นการร่างภาพด้วยเส้น เมื่อเส้นต่อกันจนเกิดเป็นผิวแบบ 2 มิติ 
แล้วก็สามารถเปลี่ยนพื้นผิวให้เป็นรูปทรงแบบ 3 มิติได้ทันที โดยส่วนใหญ่จะถูกน ามาใช้ในงาน
ออกแบบเชิงสถาปัตยกรรม งานออกแบบภายในและภายนอก การออกแบบกลไกลการท างานของ
เครื่องจักร เฟอร์นิเจอร์ ภูมิประเทศ ผลิตภัณฑ์ รวมไปถึงงานออกแบบฉาก อาคาร และสิ่งก่อสร้าง  
ในเกม หรือจะเป็นการจัดฉากท า Story Boards ในงานภาพยนตร์หรือละครโทรทัศน์ก็สามารถท าได้ 
 
 
 
 
  

SketchUp เป็นโปรแกรมสร้างโมเดลสามมิติ ซึ่งมีเครื่องมือที่ใช้งานง่าย สามารถใช้งาน
ร่วมกับ Google Map เพ่ือสร้างโมเดลอาคาร โชว์ภาพตัดขวางของโมเดล  อีกท้ังยังจ าลองการแสดง
แสง เงา ตามวันที่และเวลาจริงได้อีกด้วย นอกจากนี้ยังสามารถโชว์มองมุมมองต่างๆ ของโมเดลเป็น
แอนิเมชั่น หรือจะแปลงเป็นไฟล์ต่างๆ เพ่ือน าไปใช้ร่วมกับโปรแกรมอ่ืนได้ เช่น Photoshop , 
AutoCAD หรือ 3Ds Max เป็นต้น 
  

ท าความรู้จักกับโปรแกรม SketchUp 

ความสามารถของโปรแกรม 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 
 

SketchUp เป็นโปรแกรมท่ีมีความสามารถสูง แต่กลับมีความต้องการของระบบต่ า แต่
อย่างไรก็ตามในการท างานกับโมเดลที่มีความซับซ้อนมาก ๆ เครื่องคอมพิวเตอร์จ าเป็นต้องมีความเร็ว
พอสมควร เพื่อให้การแสดงผลและการท างานเป็นไปอย่างลื่นไหล โดยทาง Google ได้ก าหนด 
ความต้องการพื้นฐานของระบบเอาไว้ดังนี้ 

ระบบปฏิบัติการ    :  Microsoft Windows(R) XP / Vista / 7 
ความเร็ว CPU           :  1 GHz 
หน่วยความจ า RAM    :  512 MB ส าหรับ XP และ 1 GB ส าหรับ Vista / 7 
Harddisk                :  300 MB ส าหรับการติดตั้ง โปรแกรม 
การ์ดแสดงผล           :  128 MB ส าหรับ XP และ 256 MB ส าหรับ Vista / 7 
เม้าส์                      :  แบบ 3 ปุ่มมี ล้อหมุน 
ซอฟต์แวร์ที่จ าเป็น      :  Microsoft Service Pack2 ขึ้นไปส าหรับ XP,  

   IE 7.0 ขึ้นไป  และ .Net Framework  
   เวอร์ชั่น 2.0 ส าหรับการติดต้ัง Google SketchUp Pro 

 
 
 

 
งานด้านสถาปัตยกรรม 

 งานด้านนี้ต้องพ่ึงพาโปรแกรม 3 มิติเป็นทุนเดิมอยู่แล้ว ซึ่ง SketchUp ได้มีบทบาทมากขึ้น
ส าหรับสถาปนิก แทนที่จะใช้โปรแกรม 3 มิติขนาดใหญ่ราคาแพงเหมือนก่อนหน้านี้ เนื่องจากท างาน
ได้รวดเร็วขึ้นไม่ต้องวุ่นวายกับเครื่องมือมากนัก 
 

งานก่อสร้าง 
 SketchUp สามารถวาดแปลนงานก่อสร้างและบอกขนาดอย่างละเอียดได้แม่นย า และมี
เครื่องมือส าหรับพิมพ์ Blue Print หรือพิมพ์เขียวได้เลย จึงเป็นเครื่องมือที่ครบถ้วนในตัวส าหรับ 
งานออกแบบด้านก่อสร้าง 

 
งานด้านโครงสร้างเบา 

 งานก่อสร้างเบาหรือขนาดย่อมที่ต้องมีการออกแบบและน าเสนอกับลูกค้า SketchUp เป็น
เครื่องมือที่ท างานได้รวดเร็ว จัดแสงให้สมจริงได้ไม่ด้อยกว่าโปรแกรม  3 มิติระดับมืออาชีพ  
(ใช้ร่วมกับโปรแกรม Vray ซึ่งเป็นโปรแกรมภายนอกส าหรับเรนเดอร์สภาพแสงให้ชิ้นงาน)  
  

การใช้งาน SketchUp ในงานด้านต่างๆ 

ความต้องการพื้นฐานของระบบ 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
งานด้านวิศวกรรม 

 SketchUp สามารถน าเสนองานออกแบบระบบต่างๆ ให้เข้าใจง่ายส าหรับผู้ด าเนินโครงการ
ที่ไม่ใช่วิศวกรอีกท้ังยังมีฟังกชั่นท าให้ชิ้นงานมีการเคลื่อนไหวประกอบการน าเสนอได้  
 

งานด้านออกแบบเชิงพาณิชย์ 
 ร้านค้าต่างๆ เกิดขึ้นอย่างรวดเร็วในปัจจุบัน การออกแบบหรือปรับแต่งแก้ไขต้องแข่งกับเวลา 
SketchUp จึงเป็นเครื่องมือที่ตอบโจทย์การออกแบบ เพราะเป็นโปรแกรมท่ีมีขนาดเบา ท างานได้  
กับทุกเครื่อง ส่งต่องานได้ง่ายและหลากหลายรูปแบบ 
 

งานด้านการออกแบบภายใน 
 นักตกแต่งภายในสมัยใหม่ใช้เครื่องมือออกแบบงานได้โดยไม่ต้องใช้มือวาดอีกต่อไป 
วัตถุประสงค์โต๊ะ ตู้ เตียงต่างๆ สามารถหาดาวน์โหลดมาใช้ได้จาก 3D Warehouse ไม่จ าเป็นต้อง
สร้างวัตถุแต่ละชิ้นด้วยตัวเอง การออกแบบภายในจึงเป็นงานที่ส าเร็จรูปอย่างมากโดยใช้ SketchUp 

 

งานด้านสถาปัตยกรรมทิวทัศน์ 
 ไม่เพียงแค่งานระดับออกแบบภายในเท่านั้นที่ SketchUp สามารถท าได้ การสร้างโมเดล
ทิวทัศน์ก็ท าได้ง่ายดาย โดยวัตถุท่ีเป็นอาคารบ้านเรือนก็สามารถดาวน์โหลดได้จาก 3D Warehouse 
เช่นกัน รวมทั้งภูมิประเทศต่างๆ ก็สามารถใช้เครื่องมือพ้ืนฐานของโปรแกรมในการสร้างได้
เช่นเดียวกัน 

 
งานด้านวางผังเมือง 

 SketchUp สามารถขึ้นรูปโมเดลโดยใช้ภาพถ่ายจริงมาเป็นแบบในการวาด ดังนั้นจึงสามารถ
ขึ้นรูปอาคารสิ่งก่อสร้างต่างๆ ให้เหมือนจริงได้ไม่ยาก  SketchUp ยังมีความสามารถในการแสดง 
แสงเงาได้อย่างสมจริงตามช่วงเวลาและฤดูกาลต่างๆ ของปีได้ ท าให้การออกแบบผังเมืองมีตัวช่วยที่มี
ประสิทธิภาพและใช้งานง่าย 

 
งานด้านออกแบบเกม 

 เกมในปัจจุบันมีภาพกราฟิกที่พัฒนาไปอย่างมาก ผู้พัฒนาเกมจ านวนไม่น้อยใช้ SketchUp 
ในการขึ้นรูปโมเดลที่เป็นองค์ประกอบต่างๆ ของฉากหรือแม้แต่ตัวละครเองก็ตาม SketchUp 
สามารถสร้างฉากจ าลองและ Storyboard ของเกมและยังมีโปรแกรม Plug-in ภายนอกที่สามารถ
เชื่อมต่อชิ้นงานที่สร้างให้ใช้ร่วมกับโปรแกรมพัฒนาเกมได้โดยตรงอีกด้วย 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
งานด้านภาพยนตร์และบันเทิง 

 SketchUp เป็นเครื่องมือทุ่นแรงในการจ าลองฉากของภาพยนตร์หรือเวทีการแสดงต่างๆ  
มีเครื่องมือ Walk Through ที่ท าให้เราเคลื่อนที่อยู่ในฉากเหมือนก าลังเดินอยู่ในโลก 3 มิติ และมี
เครื่องมือมองไปรอบๆ เหมือนเราก าลังยืนอยู่ตรงจุดนั้น ซึ่งเหมาะกับงานด้านการถ่ายท าอย่างมาก  

 
งานไม้ 

 การออกแบบงานไม้ด้วย SketchUp ช่วยลดความเสี่ยงก่อนจะท าเฟอร์นิเจอร์ เราสามารถ
ออกแบบเพื่อน าเสนอและปรับแก้จนถูกต้องก่อนลงมือท า ส าหรับลายไม้นั้น สามารถก าหนดพ้ืนผิว
วัตถุได้หลากหลาย และปรับคุณสมบัติพื้นผิวจนดูสมจริงได้ด้วย 

 
งานด้านการศึกษา 

 ครูผู้สอนสามารถใช้ SketchUp เป็นเครื่องมือสร้างสื่อการสอนที่น่าสนใจให้กับนักเรียนได้ 
โดยเฉพาะวิชาฟิสิกส์ เนื่องจาก SketchUp มีโปรแกรมเสริมอยู่มากมายและหนึ่งในนั้นมีโปรแกรม 
Plug-in ที่จ าลองสภาพแรงโน้มถ่วงให้กับฉากนั้น ท าให้วัตถุมีการหล่น กระทบกันอย่างสมจริง 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

ใบงานที่ 1 

 
ค าชี้แจง  ให้นักเรียนตอบค าถามต่อไปนี้ 
 

1. โปรแกรม SketchUp มีคุณลักษณะและความสามารถอย่างไร 
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
............................................................................................................................................ 
 

2. โปรแกรม SketchUp น าไปใช้ประโยชน์ในงานด้านใดบ้าง  
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
................................................................................................................................................................
............................................................................................................................................ 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
ใบความรู้ที่ 2  

เร่ือง เร่ิมต้นใช้งานโปรแกรม SketchUp  
 
 
 
 
 
 

การเปิดใช้งานโปรแกรม SketchUp มีวิธีเปิดใช้งาน 2 วิธี คือ  
 
วิธีที่ 1  

ดับเบ้ิลคลิกท่ีไอคอนโปรแกรม                บนเดสก์ท็อป 
 

วิธีที่ 2  
1. คลิกท่ีปุ่ม Start   

 

 
 

2. เลื่อนเมาส์ไปท่ี All Programs แล้วคลิกเมาส์  
3. เลื่อนเมาส์ไปท่ี  Google SketchUp 8  แล้วคลิกเลือกเพ่ือเปิดใช้งานโปรแกรม  

 
  

เปิดใช้งานโปรแกรม  SketchUp 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
4. จะพบกับหน้าจอ Welcome  to SketchUp ซึ่งเป็นหน้าต่าง ช่วยเหลือและ

ก าหนดค่าเริ่มต้นส าหรับใช้งานโปรแกรม 
 

 
 

ในหน้าต่างนี้จะประกอบไปด้วยรายละเอียดดังนี้  
Learn เป็นส่วนที่เชื่อมต่อไปยังเว็บไซต์ช่วยให้ผู้เริ่มต้นใช้งานได้เรียนรู้วิธีการใช้งาน

โปรแกรม 
License เป็นส่วนของการลงทะเบียนใช้งานโปรแกรม 
Template เป็นการเลือกเมื่อเปิดโปรแกรมครั้งแรกเป็นส่วนส าคัญท่ีสุดในตอน

เริ่มต้นท างาน 
ปุ่ม Start using SketchUp ส าหรับเริ่มต้นใช้โปรแกรม 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

5. คลิกท่ีปุ่ม Choose Template 
6. เลือกรูปแบบหน้าจอและหน่วยวัดที่ใช้ในหน้าจอ จากเทมเพลต 
7. คลิกปุ่ม Strat using SketchUp เริ่มต้นใช้โปรแกรม SketchUp 

 

 
 
จะปรากฏหน้าจอโปรแกรมข้ึนมาดังรูป แสดงไดอะล็อกบ็อกซ์ Instructor อธิบาย

วิธีใช้เครื่องมือต่างๆ 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 
 
 

 
 

1. Title Bar แถบแสดงชื่อไฟล์ที่ก าลังใช้อยู่ 
Menu bar  แถบเมนูบาร์  เป็นแถบค าสั่งหลักที่ใช้ในการควบคุมการท างานหลักของโปรแกรม 

2. Tool bar  แถบเครื่องมือ แสดงชุดเครื่องมือซึ่งแบ่งหมวดหมู่การท างานอย่าง 
ชัดเจน เมื่อเปิดโปรแกรมครั้งแรก จะแสดงชุดเครื่องมือไว้ด้านบน ซึ่งเราสามารถเปลี่ยนต าแหน่งของ
แถบเครื่องมือได้ 

3. Drawing Area  พ้ืนที่การท างาน  เป็นส่วนที่เราใช้สร้างงาน 

4. เครื่องมือแสดงข้อมูลของโมเดล  ประกอบด้วย  แสดงต าแหน่งโมเดลบน  

Google Maps,  แสดงเครดิตผู้จัดท า ,   ลงทะเบียนใช้งานกับ Google 

5. เครื่องมือแสดงค าแนะน าในการใช้งาน ประกอบด้วยเครื่องมือ  Show  
Instructor เปิดหน้าต่าง Instructor และแถบอธิบายวิธีการใช้งานเครื่องมือบน Google Sketchup 
ซึ่งจะเปลี่ยนไปตามแต่ละเครื่องมือ 
  

ส่วนประกอบหน้าจอโปรแกรม 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 

6. ช่องก าหนดค่าของเครื่องมือขณะใช้งาน จะเปลี่ยนค่าไปตามเครื่องมือที่ใช้ เช่น  
เมื่อคลิกเครื่องมือ Line ที่ช่องนี้จะแสดงค่า Length เพ่ือให้เราใส่ความยาวของเส้น เป็นต้น โดยพิมพ์
ค่าท่ีต้องการพร้อมหน่วยวัด แล้วกดคีย์ Enter ( สามารถพิมพ์ไปได้เลย ไม่ต้องคลิกท่ีช่องนี้ก่อนพิมพ์
แต่อย่างใด ) หรือใช้บอกค่าองค์ประกอบขณะท างานบนพ้ืนที่ท างานว่าตรงตามที่ต้องการแล้วหรือยัง 
เช่น เมื่อใช้เครื่องมือ Protractor วัดมุม ก็จะแสดงขนาดมุมในช่องนี้ เป็นต้น 
 
 
 
 
 

แกนหลักท่ีใช้ในการอ้างอิงของโปรแกรม  SketchUp   มี  3  แกน คือ 
1.1 แกน  x  (แกนเส้นสีแดง) 
1.2 แกน  y  (แกนเส้นสีเขียว) 
1.3 แกน  z  (แกนเส้นสีน้ าเงิน) 

 

          เมื่อต้องการสร้างงานให้ตรงกับแกนใด  ควรจัดมุมมองให้อยู่ในแนวของแกนนั้นแล้วจึงท าการ
สร้างงานขึ้นมา  การจัดมุมมองจึงมีส่วนส าคัญในการสร้างงาน เช่น  การสร้างรูปสี่เหลี่ยมระหว่าง
แกน x  กับแกน y  และแกน  x  กับ  แกน  z     

  

การอ้างอิงแกน 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

 

 
 
 
 

ปกติหน่วยวัดที่แสดงขนาดในช่อง Value Control Box ขณะที่ใช้แต่ละเครื่องมือสร้าง
ชิ้นงานนั้นจะเป็นหน่วยวัดที่ได้ตามรูปแบบเทมเพลตที่เลือกไว้ในตอนแรก ถ้าต้องการเปลี่ยนเป็น
หน่วยวัดอ่ืนก็สามารถท าได้ดังนี้ 
 

1. คลิกเมนู Windows > Model Info 
 

 
  

การก าหนดหน่วยวัด 
 

คลิก Model Info 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
2. เมื่อปรากฏหน้าจอ Model Info ให้เลือกแท็บ Units ก าหนดหน่วยวัดที่ต้องการ 

 

 

 
รายละเอียดของการก าหนดหน่วยวัดมีดังนี้ 
 Length Units  หน่วยวัดระยะ 

 Format เลือกรูปแบบของหน่วยวัด ถ้าเลือกเป็นแบบ Decimal หรือทศนิยม
สามารถเลือกหน่วยวัดได้ เช่น เซนติเมตร (Centimeters), มิลลิเมตร 
(Millimeters) เป็นต้น ถ้าเลือกแบบ Architectural จะบังคับเลือกหน่วยวัดเป็นนิ้ว 
(Inches) และถ้าเลือกแบบ Engineering จะมีหน่วยวัดเป็นฟุต (Feet)  

 Precision ก าหนดต าแหน่งทศนิยม 
 Enable Lenghts snapping ควบคุมระยะในการเลื่อนเมาส์ (จากจุดหนึ่งไปอีกจุด

หนึ่ง) โดยให้ Snap ตามระยะท่ีก าหนด 
 Display units format ให้แสดงหน่วยวัดต่อท้ายค่าระยะ เช่น 3.24” คือ 3.24 นิ้ว 

เป็นต้น 
 Angle Units หน่วยวัดมุม 

 Precision ก าหนดต าแหน่งทศนิยม 
 Enable angle snapping ควบคุมระยะในการปรับมุม ให้ Snap ตามขนาดที่

ก าหนด 
  

1 

2 3 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 

 

 ชุดเครื่องมือ (Toolbars) ที่แสดงเป็นไอคอนอยู่ด้านบนเมื่อเปิดโปรแกรมใช้งานครั้งแรก 
เป็นชุดเครื่องมือมาตรฐาน เรียกว่า “Getting Started” เปิดด้วยเมนู View > Toolbars สังเกตที่
หน้าค าสั่ง Getting Started ถูกเลือกอยู่ นอกจากนี้ยังมีชุดเครื่องมือ Large Tool Set ซึ่งเป็น
เครื่องมือมาตรฐานชุดใหญ่ ให้เลือกเปิดเครื่องมือ Large Tool Set ไว้ จะเห็นเครื่องมือแสดงอยู่ทาง
ซ้ายมือของหน้าจอ (แนะน าให้เปิดไว้เพื่อง่ายในการเรียกใช้เครื่องมือต่างๆ )  

 
คลิกเมนู View > Toolbars > เลือกชื่อเครื่องมือ 
 

 
 

 
 

 นอกจากเครื่องมือที่แสดงบนชุดเครื่องมือ Large Tool Set แล้ว ยังมีชุดเครื่องมืออ่ืนๆ อีก 
ซึ่งสามารถเปิดข้ึนมาใช้งานได้โดยคลิกเมนู View > Toolbars > เลือกชุดเครื่องมือ  
 

Getting Started 

Large Tool Set 

เปิดใช้งานชุดเคร่ืองมือ 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 

 
 
 
 การเก็บงานหลังจากสร้างงานแล้ว สามารถบันทึกไฟล์เก็บไว้เรียกใช้งานในภายหลังโดยไฟล์ที่
ได้จะเป็นนามสกุล .skp  มีข้ันตอนดังนี้ 
 

1. เลือกค าสั่ง File >  Save หรือ Save As 

 
 

2. เลือกโฟลเดอร์ส าหรับเก็บไฟล์ 
3. ตั้งชื่อไฟล์ 
4. คลิกปุ่ม Save 

 

การบันทึกงาน 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
 

 
 
 
 หลังจากใช้งานเสร็จเรียบร้อยแล้วต้องการปิดโปรแกรม สามารถท าได้ดังนี้  

วิธีที่ 1 คลิกปิด   
วิธีที่ 2 เลือก ค าสั่ง File > Exit 

 

 
  

2 

3 4 

การปิดโปรแกรม 
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รู้จักกับ SketchUp 

เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 

 
ใบงานที่ 2 

 
 
อธิบายส่วนประกอบและหน้าที่ของส่วนประกอบต่างๆ ของโปรแกรม SketchUp 

 

 
 
หมายเลข 1 ……………………………………………………………………………………………………. 
หมายเลข 2 ……………………………………………………………………………………………………. 
หมายเลข 3 ……………………………………………………………………………………………………. 
หมายเลข 4 ……………………………………………………………………………………………………. 
หมายเลข 5 ……………………………………………………………………………………………………. 
หมายเลข 6 ……………………………………………………………………………………………………. 
หมายเลข 7 ……………………………………………………………………………………………………. 
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เอกสารประกอบการเรียนการใช้โปรแกรม SketchUp 
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